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The Story
      It was the greatest crisis to befall the Alliance of Confederated Worlds...

      Near the heart of Confederation territory lay a massive binary black hole in the Halkyon Prime 
system.    For centuries, differential gravimetric engines had tapped the immense store of energy in 
this system and powered the hundreds of Allied worlds.    With almost unlimited energy, these worlds 
were prospering.    Since energy could be converted directly into matter, limited resources became a 
problem of the past.    And with that problem also went the problems of greed, over-crowding and 
war.    Life was good.    But all of that was about to change...

      Dr. Johann K. Tastrophe was upgrading one of the Diff-Grav engines with a new heavy neutrino 
reaction core.    As he guided the engine back to its position between the black holes, he was 
unaware that his work had been sabotaged.    A build-up of heavy neutrinos near the engine began 
creating a local anomaly in the gravitational field.    The change was so slight that it was never 
detected by the remote monitors.

      However, the gravitational distortion was strong enough to begin drawing the black holes into an 
ever-tightening orbit.    At that final instant when their event horizons merged, a single black hole of 
enormous mass shattered the very fabric of space with its birth.

      ...the warning arrived via tachyon relays only months ahead of the first shock wave.    The 
Confederation began an immediate and frantic evacuation.    Huge cargo vessels, never intended for 
long-term human occupation, were converted into escape pods, each capable of carrying a million 
passengers.    Military craft were retrofitted for use as escape pods.    Even civillian recreational craft 
were pressed into service.    The resources of a hundred worlds were focused on a single goal:    
survival.

      Thousands of ships, and billions of passengers, raced outward from Confederation territory as 
fast as possible.    When the shock wave reached the first unprotected Allied world, it shattered the 
planet into a million fragments without even the slightest hesitation.    The heavy shield generators on
the escape ships were the only thing that prevented the complete destruction of the Confederation 
when the shock wave finally overtook them.

      But the shock wave itself was only the first of the threats to the escaping colonists.    The planetary
fragments from a hundred worlds and countless moons were following just behind the shock wave.    
The once powerful shields of the escape vessels were now drained beyond their limits, and were 
now incapable of protecting the craft from this meteoric shower.    In addition, as the refugee fleet 
moved ever further away from Confederation space, hostile alien races were encountered.

      Thus was created the "Street Sweeper Squadron."    Led by Lieutenant Francois deBris, it 
consisted of only the best pilots and the most capable military craft.    Charged with the objective of 
protecting the remaining refugees, their mission was to sweep out around the slower moving fleet 
and clear a safe path for the vulnerable escape vessels.

      The mission is a difficult one, and it isn't likely to get any easier.    It is a thankless job, no more 
than a galactic garbage gatherer, and if a pilot can't handle it...well, he dies alone.

      But the lives of countless refugees depend upon the Squadron, and it is only through their diligent 
efforts that the Confederation has any hope of surviving until tomorrow...



How To Play
 To start a new game:
      From the title screen press [F2] to begin, or select New from the Game menu.    Then select either
a one- or two-player game.    During a competitve 2-player game each player's ship can be destroyed
by the other player.    During a cooperative 2-player game both ships are immune to damage from the
other player.
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Objective
      If it moves, shoot it.    If it can't be shot, collect it.

      The object of the game is to clear the entire screen of space debris by blasting it to bits with your 
ship's weapons.    You must avoid colliding with the asteroids, while collecting bonuses and avoiding 
and destroying any enemy ships that appear.    After you have cleared all of the debris from a 
particular wave, a new wave will begin, each successive wave becoming more and more difficult.    
You are given 4 ships with which to accomplish your mission.



Your Ship

      The Splorkon Systems XJ-37 is a heavily armed fighting vehicle, ideal for close combat and 
clean-up operations.    It has a standard stardrive engine with optional turbo-thrust capability, 7 
configurable weapons ports, 2 onboard shield generators and armor plating.

      Each of the three main sub-systems (engines, weapons and shields) are each independently 
powered by their own battery and generator systems.    The primary advantage of this design is the 
continued availability of a system even if other systems have been exhausted.    This prevents, for 
example, the shield system from failing simply because the engine system has been overloaded.
      However, this is also a disadvantage of the design. Not all of the ship's total power reserve is 
available for use equally by all of the ship's sub-systems.    It is not possible to operate the shield 
system with the weapon system's power supply, for example.
      Thus, the optimally configured vehicle is one in which the balance of power supply capacities best
matches the intended mission.    Typically, all 3 power supplies are expected to be configured for 
approximately the same capacity.
      The battery component of the power supply will determine the maximum peak energy availability 
at any moment, while the generator component will determine the rate at which the battery is 
recharged after depletion.    An oversized generator can somewhat compensate for an undersized 
battery, or vice versa.
      The current battery level of each sub-system is indicated by the energy level bar graph displays 
within the game.    Collecting certain bonus items can increase battery capacity.    The generator's 
recharge rate is not displayed, but you can collect bonus items which can affect this rate.

      ENGINES
      The engine system affects the speed of your ship.    There is a turbo mode available (Turbo 
Engines) which can double the thrust output for a limited time.    The engine system can also 
optionally dampen the recoil from weapons fire (Recoil Dampers) and automatically bring the ship to 
a complete stop whenever thrusters are disengaged (Auto-Braking).    Recoil Dampers allow you to 
avoid losing forward velocity when firing weapons, thus saving engine energy.    Auto-Braking causes 
you to lose a lot of velocity, but allows you to make very tight turns without overshoot.    Care should 
be exercised when Auto-Braking is used in conjuction with the shields - see the section on shields 
below for more information.
      Your ship also has a reverse thruster mounted at the front of the ship, enabling you to brake your 
forward momentum or thrust backwards.

      WEAPONS
      The weapon system consists of 7 configurable armament ports, arranged as 5 armament 
systems.    3 of the systems consist of a single armament port, while the other 2 consist of a pair of 
armament ports.    The paired armament ports cannot be activated independently, they must be 
configured as a pair.    The main gun is a center-mounted, forward firing weapon.    The auxiliary guns
are a pair of side-mounted, forward firing weapons.    The side guns are a pair of side-mounted, side 
firing weapons.    Both the tail gun and the mine gun are rear-mounted, rearward firing weapons.
      To acquire superior ammunition, or activate guns other than the main gun, you must collect 
weapon "bonuses" or "power-ups".    Each power-up provides you with a limited supply of a particular
type of ammunition.    When the ammunition for a particular gun is exhausted that gun will become 
inactive.    However, the main gun has an unlimited supply of normal ammunition, and is always 
available even after the other guns have become inactive.

      Additionally, your ship may be equipped with an "outrigger" - an external weapons pod that tracks 



your ship's movement.    There are two types of outriggers:    one which fires forward in the same 
direction as your ship is facing, and one that fires outward in the direction that the outrigger is facing. 
The outrigger is an especially powerful addition to your ship in later waves, since it contains it's own 
energy source - it provides extra fire-power for free.    The outrigger uses the same ammunition as 
the main gun.    Armed with the outrigger and superior main gun ammunition, you are truly a force to 
be reckoned with!

      A special "spray" weapon for the main gun may also be acquired from enemy ships - keep your 
eyes open for opportunities to collect the alien escape pods!    If you collect additional pods while the 
spray gun is already active you will increase the width of the spray.

      SHIELDS
      The default shield generator is known as the Nudger Shield.    If your ship contacts another object 
with these shields activated, the shields will eventually "nudge" you gently away from the object.    
You may even penetrate the object for a short period before the shields accomplish their job, 
however your ship will be completely protected as long as the shields are active.
      The more powerful shield generator is known as the Repulsor Shield.    It will
actively "bounce" you away from other objects that your ship comes into contact with, without 
allowing your ship to penetrate the other object.    This means that you can usually activate your 
shields for a much shorter period of time than with the Nudger Shields, while still protecting your ship
during the collision.
      There is a potentially dangerous effect which can occur when the shields and engine Auto-Braking
are used simultaneously.    As the shields attempt to move you away from the colliding object, the 
engines will simultaneously try to bring the ship to a complete and immediate stop.    This may 
prolong your collision with the other object for a period long enough to exhaust your shields!    In this 
situation you should quickly turn and thrust your way out, or jump to hyperspace.
      Either shield generator may optionally be charged with extra energy which will allow it to destroy 
objects that it contacts (Destructo Shields).    Thus, your shields can actually function as a weapon 
system of sorts.

      Additionally, the ship may be covered with one or more layers of armor.    Each layer of armor is 
capable of dissipating the energy from a single collision.    However, armor is not automatically 
recharged after use as the shields are - it is a "disposable" item.    Therefore, it is advisable to use 
your shields instead of armor whenever possible.    Save your armor for emergencies when you've 
run out of shield energy and have no other options.



Default Controls
      The default controls are listed below.    You may customize your keyboard and joystick setup by 
choosing the Controls item on the Options menu.

KEYBOARD:
---------
Left Arrow      Rotate Counter Clockwise
Right Arrow     Rotate Clockwise
Up Arrow        Thrust
Down Arrow      Reverse Thrust
Control         Fire
Shift           Shields
Spacebar        Hyperspace
F3              Pause

MOUSE:
------
Move Mouse      Rotate to face pointer
Left Button     Fire
Right Button    Thrust
(Use keyboard to activate shield, reverse thrust and hyperspace)

JOYSTICK:
---------
Left            Rotate Counter Clockwise
Right           Rotate Clockwise
Up              Thrust
Down            Reverse Thrust
Button 1        Fire
Button 2        Shields
Button 3        Hyperspace

(Note that Button 3 may not be available on all joysticks.)

      A note on using the mouse as controller:    The mouse is a difficult and non-intuitive controller to 
use for this particular game.    It is not recommended, however it is provided for completeness.    
When using the mouse, it will still be necessary to use the keyboard for some functions, as there are 
not enough buttons on the mouse itself to handle them all.



Displays
Along the right and bottom of the main game area are displayed various status indicators which help 
keep you informed of the progress of the game and the state of your ship.

Your current score is displayed in the upper right corner.    Just below it is the name of the current 
sector.

Below the score display are three colored gauges which track the energy level of your ship.
      The red gauge labeled "E" tracks your Engines energy level.
      The green gauge labeled "W" tracks your Weapons energy level.
      The blue gauge labeled "S" tracks your Shields energy level.
You will notice these gauges falling and rising as you use the various systems and they recover.    If 
any gauge falls to zero, then that system will be temporarily unavailable until enough time has 
passed to allow it to recharge.

A graphic depiction of your ship is displayed just below the energy gauges.    On this display is shown
both your current weapons configuration as well as your current armor.    Active weapons ports will be
indicated by a red light near the respective port.    Armor level is indicated by the brightness of the 
outline around the ship - a bright outline indicates a high armor level, a dark outline indicates low 
armor level.    If no outline is visible you have no armor remaining.

      The current wave number is displayed just below the ship status display.

      The number of remaining ships is displayed at the bottom right.    If you have more than 5 ships 
remaining, the total number of ships will be displayed as a numeric value superimposed over the 
symbolic display.

The bottom status panel is the message display.    Messages will appear informing you of which 
particular bonus you've collected, the approach of aliens, the status of your ship, etc.    At the end of 
each wave it will also display a marksmanship rating which describes your shooting accuracy - it is a 
ratio between the total number of shots fired and the number of hits scored.    You can expect your 
marksmanship rating to go down if you have multiple weapons enabled - since there will be more 
total bullets fired there will also probably be more misses.



Waves
      The game consists of a series of "waves" of debris and aliens which you must destroy.    A wave is
over when all of the rocks, aliens and bonus items have been cleared.    After one wave ends, the 
next wave will begin.      Each wave gets a little more difficult: a few more rocks to destroy, earlier 
appearance of aliens,    more aggressive aliens, etc.    This will continue indefinately - there is no 
practical upper limit on the number of waves.

      A mission briefing screen will appear every few waves.    It may give you some hints as to what 
you may expect in upcoming waves.    Each wave is slightly different, and some have special 
combinations of rocks, mines, aliens and bonuses.    The mission briefing screen can help you 
prepare for these special waves and provide clues to special scoring opportunities.



Bonuses
      As the space debris is destroyed, occasionally a spinning disc - shaped bonus item will be 
released which you can collect.      You must fly your ship over a bonus in order to collect it.    They    
only remain visible for a short time, so if you want that bonus you'd better chase it down right away!

      Also, every once in a while any of the bonus items may also contain an extra ship!    So it really 
helps to collect as many of them as you can.

      There are four main categories of bonuses, and variations within each category.    Some of the 
possible bonuses you may acquire are listed below:

ENGINES

Maximum energy level and recharge rate.

Friction increase/decrease, auto-braking.

Turbo engines.

Recoil dampers.

WEAPONS

Maximum energy level and recharge rate.

Weapon range and speed.

Activate weapon port or additional ammo.

Activate weapon port and change ammo type.

SHIELDS

Maximum energy level and recharge rate.

Repulsor or nudger shields.



Increase armor.

Destructo shields.

SPECIAL

Activate outrigger, grenade launcher.

      Some bonuses remain in effect indefinately until you lose your ship, others time out automatically, 
and others expire after a certain amount of use or at the end of the current wave.
      In general, the "PLUS" bonuses increase your energy and remain active until you lose your ship.   
The "LEFT-RIGHT" bonuses adjust some aspect of the indicated system (such as weapon range, 
type of shield, etc) and remain in effect until another bonus item is collected to change the setting.    
The "UP" arrows are temporary upgrades that expire once you've used them up (run out of ammo, 
use up armor, use up turbo engines).    The "QUESTION" arrows may fall into any of the above 
categories, although they are generally special upgrades which will expire with use.



Enemies
All of the aliens in the game are actively aggressive.    That is, they will hunt you, as opposed to just 
floating across the screen in random patterns.    A dextrous combination of firing and shields will 
usually defeat them without too much trouble however.    Aliens only appear once the wave is almost 
completely cleared of debris, and will stop appearing once all rocks have been destroyed.

Tol`Doth -    This is a less aggressive alien.    Its ship is slightly slower and less maneuverable than 
your own.    It has a moderate weapons load but it is not a very good shot.    It becomes gradually 
more aggressive in later waves.

Myotani -    This is a more aggressive alien.    Its ship is generally faster and more maneuverable than
your own (although your collection of bonuses may alter this balance).    It has a heavy weapons load
and is a pretty good shot.    If you see one of these guys, run!    It will not appear until after the first 
few waves, (unless you hang around a long time at the end of a wave) and will gradually become 
even more aggressive in later waves.

K`rin Vahl -    This alien does not shoot at you directly, rather it drops mines behind it, hoping that 
you'll run into one of them.    Its typical strategy is to approach you straight on, then reverse course 
while dropping a load of mines - making it difficult to follow them for the kill.    It may also just drop 
long sweeping lines of mines, creating a barrier of sorts.    The mines linger around for quite a while 
before dissipating, and are just as deadly as other enemy weapons.

Preliminary intelligence reports have confirmed the presence of at least three other hostile alien 
races present in this sector.    Information is sketchy, but it is believed that the following races 
represent a threat to your mission:

Finzrath -    A light scout vehicle.

Yvittori -    A heavy fighter.

Gahr`Boj -    A mine layer.

In addition, intelligence reports have confirmed the presence of an alien referred to simply as 



"Classic".    They are not a very intelligent species, but their presence in a sector should be 
considered a threat just the same.



Scoring
      The scores listed below are based on the Moderate difficulty level.    Greater score values are 
awarded for destroying or collecting objects at higher difficulty levels.

      Extra ships are awarded every 50,000 points.

OBJECT                       SCORE
------------------------  ------------
Tiny Rock                     400
Small Rock                    300
Medium Rock                   200
Large Rock                    100

Tiny Mine (crash/shot)      400/4000
Small Mine                  300/3000
Medium Mine                 200/2000
Large Mine                  100/1000

Aliens                    1000 - 2500
Alien Patrol                  5000
Alien Mother Ship            10000
Alien Escape Pod               500

Bonuses/Power-Ups              100

The Other Player              1000



Playing Against The Computer
      To play a game against a computer-controlled opponent, simply check the Computer-controlled 
option on the Controls configuration dialog for one of the players.    Then start a new 2-player game, 
either competitve or cooperative.

      In a cooperative game, the computer-controlled player will help you to clear out the debris from 
the waves.    This may make the game easier for you, although you may get fewer opportunities to 
collect bonuses if you allow the computer-controlled player to collect them first.    The challenge in 
cooperative mode is to clear the wave while trying to score higher than the computer-controlled 
player.

      In a competitve game, the computer-controlled player is still primarily interested in clearing the 
wave of debris.    However, it will defend itself against your weapons, and will attack you if you get too
close.    The computer-controlled player is generally a much more challenging opponent than the 
aliens.    The computer-controlled player becomes increasing more aggressive towards the other 
player at higher difficulty levels.    The challenge in competitive mode is to clear the wave while 
avoiding being destroyed by the computer-controlled player!

      The computer-controlled player does not cheat.    It obeys all the same rules as a human player, 
and it's ship is exactly the same as yours.    However, the computer-controlled player can respond 
very rapidly, often more rapidly than a human player, and it may appear at times that it must have 
cheated.    Rest assured that it did not.



      The Menus

The menus allow you to load and save games, control the appearance of the game window, adjust 
various graphical and sound-related options, find help on using the program, as well as many other 
tasks.

Game Menu
Window Menu
Options Menu
Help Menu



      Game Menu

New - Begins a new game starting with wave #1.

Open - Opens a previously saved game and begins play.

Save - Saves the current game with its current filename.    If you have not yet saved your game you 
will be prompted for a filename.

Save As - Saves the current game, prompting you for a filename.

Pause - Suspends the game.

Load Waves - (registered version only)    Allows you to load a customized Wave Configuration File 
(WCF) created with the Wave Editor.    Three additional WCF's are supplied with the registered 
version:

· MANYROKS.WCF    -    Contains waves which are more heavily populated with rocks than the 
original waves.    Also has fewer aliens.    For those who want a slightly more "crowded" and 
challenging game.

· NOALIENS.WCF    -    Contains waves which are essentially the same as the original waves, 
except that no aliens appear.    For those who like blasting rocks, but don't like the aliens.

· CLASSIC.WCF    -    Contains waves which are more like the original arcade game.    Fewer 
variations and only the "classic" alien will appear.    For those who miss the good old days.

High Scores - Allows you to view the current high score roster.

Exit - Exits the program.



      Window Menu

Normal Size -    While you may resize the game window to any size you like, the game runs best at 
its "native" resolution.    At this resolution, Windows doesn't have to scale the display, resulting in 
much better graphics performance.    You may select the Normal Size item from the Window Menu to 
return the game window to its default size.    (This is the display mode the game defaults to.)

Correct Aspect - This item may be used to correct the aspect ratio of any arbitrarily sized window.    
Aspect Correction will assure that the game window is "square" - not flattened out or stretched like a 
funhouse mirror - but still lets you pick any size you like and that your PC will support.



      Options Menu

      The Options Menu allows you to change various game settings and access optional features.

      The Music/Sound menu item allows you to select the type and volume of music and sound within 
the game.

      The Controls menu item allows you to select either keyboard, mouse or joystick control of the 
game, as well as customizing exactly which keys/buttons perform each of the various actions.

      The Preferences menu item allows you to change the speed of the game, as well as enable or 
disable various additional features.

Music and Sound
Controls
Preferences



Music and Sound

      The Music and Sound dialog box allows you to turn music and sound effects on or off, adjust 
volume, optimize the music for your particular sound card and control the number of channels used 
to mix sound effects.

Music    -    The check box allows you to turn the music on or off.    The volume slider allows you to 
adjust the volume of the music.

Optimize Music For    -    If you have a sound card which uses FM synthesis to generate music, such
as a SoundBlaster or compatible, you may want to select the music which has been optimized for FM
synthesis sound cards.    If you have a sound card which uses wavetable synthesis to generate 
music, such as the AWE32, you may want to select the music which has been optimized for General 
MIDI.    Simply select the type of music which sounds best in your opinion with your sound card.

Sound    -    The check box allows you to turn the sound effects on or off.    The volume slider allows 
you to adjust the volume of the sound effects.

Sound Channels    -    Allows you to choose the number of channels used for mixing digital sound.    
A lower number may improve performance on slower PC's, although sound quality may be reduced.   
Select the highest value which your PC can handle.



Controls

      The controller configuration dialog box allows you to choose either keyboard, mouse or joystick 
control, as well as customize which keys or joystick buttons activate each of the functions of your 
ship.
      To customize the controls, press the "Configure" button next to the controller you wish to 
configure.    A separate dialog box will pop up allowing you to define exactly how the controller is 
configured.
      Note that using the mouse as a controller still requires that the keyboard be used to activate some
functions.    The keys listed under the keyboard section for shield and hyperspace will continue to 
operate when mouse control is selected.    Note also that you'll probably want to turn off the "Hide 
Mouse" option on the Preferences dialog box so that you can see where the mouse pointer is.
      The keyboard controls also remain active while using the joystick.

      Be careful when redefining the controls for a 2-player set-up.    If both players use the same
controller, or share the same keys, very weird things can happen!

      The Computer-controlled option allows you to play a 2-player game against the computer.    The 
computer will handle all of the controls for the selected player using an artificial brain.

Keyboard Configuration
Joystick Configuration



Keyboard Configuration

      To change the keyboard configuration, simply click on the edit box for the desired control then 
press the key you wish to use.



Joystick Configuration

      To change the joystick configuration, simply select an axis or button from the list corresponding to 
the function you wish to redefine.



Preferences
Overall

Mission Briefings -    If this option is enabled, you will see the mission briefing screen every few 
waves.    If it is disabled, the mission briefings will be skipped and consecutive waves may be played 
uninterrupted.

Hide Mouse -    If this option is enabled, the mouse cursor will be automatically hidden whenever it 
passes over the game portion of the window.

Crash Shake - If this option is enabled, the display will "shake" whenever your ship is destroyed or 
collides with an object with the Repulsor shields.    If this option is disabled no "shaking" will occur.

Bonus Blink - If this option is enabled, bonus items (power-ups) will blink on and off for a short time 
just before disappearing.

Game Speed

This slider affects the master "clock" of the game, allowing you to speed up or slow down game play. 
Note that it functions as a limit on the speed of the game - it will not make the game run any faster 
than your PC can support otherwise.    If you have a fast Pentium, you will be able to use all of the 
speed settings, and the fastest setting will probably be way too fast!    If you have a slower 486, you 
will notice that increasing the speed beyond a certain point ceases to have any effect - at this point 
you have reached the hardware limit of your PC.    If you wish to make the game faster you should try
disabling some of the options listed below under Graphic Detail.

Message Duration

This slider allows you to control the amount of time that status messages remain visible.    Move the 
slider to the left to shorten the time, or to the right to lengthen the time.

Difficulty

Easy, Moderate, Hard, Insane, Psychotic - Select one of these items to set the difficulty level.    On 
the easy and moderate difficulty levels the number of rocks per wave increases more slowly than 
with the hard difficulty level.    The easy and moderate difficulty levels also slow down the motion and 
firing frequency of the aliens.    A lower difficulty level also increases the chance that your ship will 
only be damaged, instead of destroyed, when hit by enemy weapons.

Brightness



      Use this control to adjust the brightness of the game for your monitor.    Slide the pointer to the 
right to increase the brightness, or to the left to decrease it.    Press the Reset button to return the 
slider to its default position.

Graphic Detail

      The graphic detail options allow you to disable or modify certain aspects of the game's graphics.    
You may wish to disable some of these options either to improve performance or to reduce screen 
clutter if you find the extra graphics distracting.

Draw Thrust - If this option is enabled, the small thrust particles coming from the ships' engines will 
be drawn.

Draw Fireballs - If this option is enabled, the fiery portion of the explosions will be drawn.

Draw Shrapnel - If this option is enabled, the small glowing embers of the explosions will be drawn.

Draw Fragments - If this option is enabled, the larger debris fragments during ship explosions will be
drawn.

Draw Backdrop - If this option is enabled, the "background" area of the game screen is filled with a 
pretty space image, otherwise it is black.

Transparency - If this option is enabled, a technique known as "alpha blending" will be used to 
improve the appearance of the explosions by making them semi - transparent.    If this option is 
disabled, the explosions will be drawn normally.    If you find that the game runs slowly on your PC, 
this is a good option to disable as it is fairly CPU - intensive.

Starfield

Draw Starfield - If this option is enabled, the background star field will be drawn.

Super Stars - If this option is enabled, the background stars will be drawn larger than normal.

# of Stars - This slider allows you control the total number of background stars which are visible on 
screen (assuming that Draw Starfield is enabled).



      Help Menu

Quick Instructions - Displays a graphic help screen.

Contents - Displays this help file.

Credits - Displays the names of those responsible for creating the game.

About - Displays version and copyright information.



Hints and Tips
The game is too difficult, I keep getting blown up:

· First, try the Easy difficulty setting on the Preferences dialog on the Options menu.    This will 
slightly reduce the total number of rocks and aliens on each wave, as well as slowing down the 
rocks and your alien enemies, and causing the aliens to fire at you less frequently.

· The difficulty setting also affects the amount of "health points" for both the rocks and aliens.    In 
later waves, an easier setting will prevent you from having to shoot each target multiple times 
before destroying it.

· Try reducing the Game Speed slider on the Preferences dialog.    This slows down the entire 
game, giving you more time in which to react.

· Save your game frequently.    If something terrible happens, simply restore your last saved game.
· Try to collect as many bonus items as possible.    If you can acquire some more powerful 

weapons or more shield energy, you may find that a previously difficult wave will become quite 
easy.    The earlier you start collecting bonus items and building up the power of your ship, the 
better off you'll be.

· However...don't be so greedy to collect bonus items that you just chase after them without 
watching out for the rocks!    No bonus item is worth dying for (except perhaps an extra ship, in 
which case you'll "break even").

· Sometimes it is easier to chase after a bonus item by flying in the opposite direction rather than 
trying to catch up to it from behind.    This way the bonus item's movement is working for you 
instead of against you.    Bonus items can travel fairly rapidly, and you may deplete your engines
before catching one if you attempt to follow it directly.

· Learn to conserve your shields for when you really need them.    Don't simply fly around with your
shields on all the time, or they may not be charged when a critical situation occurs.

· Learn how to "dog fight" with the aliens.    Simply flying at them straight on with weapons blazing 
will probably get you killed, especially as difficulty increases.    Try flying circles around them, 
then turn to face them for a quick burst of weapons, then resume your evasive manoeuvres and 
repeat as necessary.    Don't sit still!

· Don't forget about the Hyperspace key.    If you're being chased after by some nasty alien and 
your energy is too low to do anything about it...try jumping to hyperspace.    This may disorient 
the alien for just long enough for you to recover enough energy to blast 'em to bits!

· Try to capture the alien escape pods that are occassionally released after you destroy an enemy 
ship.    You'll get a nice surprise if you do!

I can't figure out how to find the bonus waves:

      There are three ways to ensure a trip to a bonus wave:

· Collect every bonus released during a wave.    You must collect at least 7.
· If the aliens release escape pods after being destroyed, collect every released during the wave.  

You must collect at least 4.
· If there are mines present at the start of a wave, destroy one of the mines before destroying a 

single rock.

I can't figure out what the cheat keys are:



      The cheat keys are intentionally difficult to activate.    First, you must press and hold the 
[Backspace] key.    Then, you must press 4 more keys all simultaneously.    This will really stretch out 
your fingers!      Here are the four key cheat combinations:

 
   [W] [I] [M] [P] - super damage bullets, one shot kills most things  
   [G] [U] [N] [S] - triple-fire (main+aux) guns and rapid weapon 
recharge  
   [S] [H] [I] [P] - gives 3 ships left  
   [A] [R] [M] [X] - gives full armor  
   [S] [I] [D] [E] - activates the outrigger  
   [G] [B] [O] [M] - gives grenades  
   [B] [F] [G] [2] - big ammo for all weapon ports (does not enable 
ports)  
   [B] [O] [N] [S] - ensure trip to bonus wave  
   [B] [R] [A] [K] - turn off auto-braking, reduce friction  
   [A] [M] [O] [#] - (where # = 1-9) gives particular ammo to main gun  
   [N] [R] [G] [#] - (where # = EWS) set maximum energy for specified 
system  
   [W] [A] [R] [P] - immediate advance to next wave  
   [S] [P] [R] [A] - full strength spray gun  
   [G] [O] [D] [Z] - God Mode, player cannot be injured
   [Z] [P] [6] [Numpad+] - massive cheat, all kinds of goodies

A handy technique is to use your right pinky finger for the the backspace, and then just hunt and 
peck for the other keys with your remaining fingers. Sorry they're so hard to get at, but isn't that what 
cheats are supposed to be?

I can't figure out how to activate the secret-weapons:

      Each weapons port has a unique super weapon associated with it. To activate the secret weapon 
the weapons port must first be enabled, you can do this by collecting power-ups or using one of the 
cheats above.    The second part of the secret is that you must have a LOT of weapons energy before
the super weapon can be activated - the weapons power meter must be at least 3/4 charged to use a
super weapon. So go collect a bunch of weapons power-ups until you have enough energy (or use 
the NRGW cheat as described above).  
      The final part of the secret involves the key combinations to fire the super weapons. You must 
press several keys in the proper sequence, and in quick succession, in order to activate the secret 
weapons.    This kind of key combo is often referred to as a "twiddle".    The combinations for each 
weapons port are listed below: 

[Thrust] [Thrust+SpinCCW] [SpinCCW] [Fire]  
- Fires the main gun special weapon, if you have the single main gun active and enough weapon 
energy available. The main gun special weapon is a serpentine spray of bullets in the forward 
direction. (With the default keyboard layout, this is a quick roll over the up-left arrows followed by the 
fire key.)  

[Thrust] [Thrust+SpinCW] [SpinCW] [Fire]  



- Fires the aux guns special weapon, if you have the dual aux guns active and enough weapon 
energy available. The aux gun special weapon is a pair of long linear chains of bullets in the forward 
direction.  (With the default keyboard layout, this is a quick roll over the up-right arrows followed by 
the fire key.)

[SpinCW] [SpinCCW] [SpinCW] [Fire]  
- Fires the side guns special weapon, if you have the dual side guns and enough weapon energy 
available. The side guns special weapon is a pair of short wide fans of bullets in the lateral 
directions.  (With the default keyboard layout, this is three quick taps - right,left,right arrow - followed 
by the fire key.)

[SpinCCW] [SpinCW] [SpinCCW] [Fire]  
- Fires the tail gun special weapon, if you have the tail gun and enough weapon energy available. 
The tail gun special weapon is a long narrow fan of bullets in the rearward direction.  (With the 
default keyboard layout, this is three quick taps - left, right,left arrow - followed by the fire key.)

[SpinCCW] [Thrust] [SpinCW] [Fire]  
- Fires the mine gun special weapon, if you have the mine gun and enough weapon energy available.
The mine gun special weapon is a ring of mines spreading out in all directions.  (With the default 
keyboard layout, this is three quick taps - left, up, right arrow - followed by the fire key.)

      Hint:    The super weapons are usually easier to activate if you're using the keyboard as a 
controller.



Troubleshooting
The game plays slowly on my computer:

· This game is intended to run adequately on a 486DX-66 with 4M of memory.    A local bus video 
card is strongly recommended.    For the best gameplay, run this game on a Pentium (tm) system
with 8M or more memory.

· This game runs best under Windows 95 (tm).
· Although this game is not guaranteed to run under all versions of Windows NT (tm), it should run 

acceptably under Windows NT Workstation 4.0.    You may experience problems with the digital 
sound effects with Windows    NT.

· This game runs best in 256 color display modes (also known as 8-bit display modes).    If you 
have Windows configured for a different display mode you may wish to try changing your display 
settings.

· This game is designed to run in a "normal" window size of approximately 640x480.    At this size, 
the display does not need to be scaled to fit the window, which is usually the best situation - 
resulting in the best mix of performance and appearance.    However, you may try reducing the 
size of the window to improve graphics performance.    This will greatly distort the game's 
appearance, and so should only be used as a last resort.

· If you are using Windows 3.x, you can improve performance by installing Win/G.    Microsoft 
released Win/G as an add-on for Windows 3.x specifically to improve graphics performance, and 
the game will take advantage of it if present.    Win/G is not required on Windows 95 systems.

· If you are running other programs in the background while playing the game, try closing them - 
they may be using up valuable system resources.    If you are running the game on a PC with 8M 
or less of memory, Windows may be "swapping" virtual memory to a disk file which can 
significantly slow down the game.    Closing all other programs may free up enough memory to 
avoid this swapping.

· You can speed up several specific aspects of the game by disabling some of the graphic detail 
by using the Preferences dialog on the Options menu.    Try turning off "Draw Backdrop" or 
"Transparency" or reducing the number of stars in the background.

· If the game appears to slow down whenever multiple sounds are played simultaneously, you may
wish to change the number of channels used by the sound mixer.    You can find this setting on 
the Music and Sound dialog under the Options menu.    A lower value may improve performance 
on slower PC's, although sound quality may be reduced.

The game window is too large for my screen, I can't see part of it:

· The game is designed to completely fill a 640x480 screen when run in a "normal" size window 
(see the Window menu, Normal Size item) when using the default desktop font.    However, the 
title bar and menu may take up extra space on your screen if you are using large fonts, thus 
reducing the amount of screen space available for the game.    If you are running at a resolution 
higher than 640x480 this should not be a problem.    If you are running at 640x480, you may 
correct this problem by either using a smaller font on your desktop, or by maximizing the game 
window.    Maximizing the game window will cause the window to scale itself to optimally fill the 
screen.    (However, note that scaling the window may distort the image somewhat and reduce 
performance.)

When I run the game with other applications the colors go crazy:



· In 256-color display modes, all running applications must share the same set of 256 colors.    
However, only one application (the active application) has control of the color palette at any one 
time - this may cause inactive applications to look "funny", since they are forced to use the 
"wrong" color palette.    An application should restore its own colors once it is again activated.    If 
you are using 256-color wallpaper it will be similarly affected by the changing color palettes.

I hear no music, or cannot adjust the volume of the music:

· The game may be unable to change the volume on some sound cards with older driver software. 
(The SoundBlaster AWE32 is one such card.)    If this happens you will not be able to adjust the 
music volume with the volume slider.    You might not hear music at all if the volume is set low.    
To solve this problem you should acquire and install the latest driver software from your sound 
card manufacturer.    (The SoundBlaster AWE32 will work correctly with the game if the latest 
driver software is installed.)

The sound effects are "choppy" or have intermittent "drop-outs":

· The game uses a Microsoft add-on called "WAVEMIX" to produce multi-channel sound.    This 
product is fairly CPU-intensive, and you may notice drop-outs on slower PC's.    Drop-outs are 
usually most noticeable when the system is very busy with other tasks such as graphics and disk
access (especially if memory is being swapped to disk).    It is possible to slightly modify the 
performance of the WAVEMIX system by editing the parameters in the WAVEMIX.INI file.    
Suggested settings are listed for several common sound cards.    You may also try reducing the 
graphics detail via the Preferences dialog on the Options menu in order to free up your CPU for 
sound chores.

· You may also try changing the number of channels used by the sound mixer.    You can find this 
setting on the Music and Sound dialog under the Options menu.    A lower value may improve 
performance on slower PC's, although sound quality may be reduced.

In two-player mode, one player is controlling both ships:

· Open the Controls dialog box and check which controller each player is using.    Make sure that 
both players aren't using the same joystick, or the mouse, or have conflicting keyboard set-ups.   
(Since the keyboard controls are ALWAYS active regardless of which controller is selected, the 
keyboard controls must ALWAYS be unique for each player.)

I can't get my joystick to work:

· The game will only recognize your joystick if you have properly installed and configured a joystick
driver within Windows.    The game does not contain any internal joystick configuration or 
calibration routines, all such functions are left to the Windows driver to take care of.    If your 
joystick is not working properly with the game, check the Windows Control Panel for an applet 
which allows you to configure and/or calibrate your joystick.

My joystick works, but it seems "backwards":



· You can either try reversing the offending axis within your joystick control applet, or simply 
redefine the joystick by using the Controls dialog on the Options menu so that the offending axis 
is reversed from the defaults.



Joystick Configuraiton






